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Introduction

The Cayuse IRB Help is designed to answer questions about what certain items on a given screen are, what they do, how they function, and
how you might use them. The content is intended to be functionally descriptive yet brief and to the point.

To access this help, click the Help link at the top of the screen in Cayuse IRB. You can search through the Help using the Contents and Index
tabs, or type a search string in the box in the upper right.

If you cannot find an answer to your question here, you should review the Cayuse IRB Support Resources page, which contains links to many
additional resources to help you with your questions and issues.
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What is Cayuse IRB?

The Cayuse Institutional Review Board (IRB) module is an easy-to-use system for electronically preparing, submitting, and routing studies for
IRB approval. All information is stored in the cloud and can be accessed securely from any location, making it simple for multiple
simultaneous users to view and share documents. Users receive electronic notifications whenever an action is required on their part, allowing
the study to proceed smoothly through each step of the process from study creation to final approval.

Cayuse IRB:

= Provides a comprehensive electronic compliance solution.

m Tracks and manages initial submissions, modifications, reportable events, and continuing reviews in a single location.
m Eliminates the need for paper forms.

m s accessed using a secure connection via your web browser.

= Helps to ensure timely submissions by automatically generating reminder notices for continuing reviews.

= Allows institutions to design custom forms that request only the information that is relevant to the study, based on information
provided by the researchers.

= Allows multiple researchers and administrators to view and work with forms at the same time.
m Tracks and compares changes between different versions of a submission.
m Enables convenient and efficient coordination of meetings and distribution of meeting minutes.

m Links IRB submissions to funding proposals in the Cayuse SP module, if licensed.

System Requirements

m Internet Explorer 9 or higher, Mozilla Firefox, Google Chrome, or Apple Safari. (Note: Safari is only provisionally supported at this
time.)
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Cayuse IRB Support Resources

Evisions provides several sources of support for Cayuse IRB users, including in-product Help, tutorials, and release notes, and a support
website with many useful resources.

In-Product Help

The Cayuse IRB Help serves as a reference guide for all of the features in the software. You can access the help by going to Help -> Open Help
in the menu. The Help contains a table of contents, an index, and a search feature.

Release Documentation

To view the release notes and release guides outlining the latest changes in Cayuse IRB, go to Help -> Release Notes within Cayuse IRB, or
click here.

Tutorials

To see a brief overview of the updated user interface introduced in Cayuse IRB 1.6, go to Help -> View Dashboard Tutorial or Help -> View
Visual Search Tutorial.

Training Materials

Evisions provides many training resources for Cayuse IRB, intended to help meet your training needs.

Additional Resources

The Evisions Support Center contains links to additional support resources:

m HelpDesk - Technical Support website where you can open a support ticket, or search the knowledgebase.
= Knowledgebase - Answers to common questions.
m Browser Support and Configuration - assistance using your favorite browser with the Evisions Research Suite.

= [RB Support - Provides links to this manual, the release guides, the Evisions blog, and the knowledgebase.
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Logging In

This is the login screen for the Evisions Research Suite applications.

) AR
Evisions . | = R:s:a ;\c\h
X Research Suite . -

™

Y

GO TO EVISIONS.COM T

Welcome to the Evisions Research Suite

Problems or

queshons?
Name Contact support
Password

© 2011-2014, Evisions, Inc.

Enter your username and password at the prompt. Then, click Sign In to launch Cayuse IRB.
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Navigating Cayuse IRB

Dashboard

When you first log in to Cayuse IRB, the Dashboard screen presents you with a quick overview of any studies you are involved with or that
require your attention.

cayuse IRB*

# Dashboard

B Studies

Studies and Submissions

The Studies and Submissions screens list the studies and submissions that you have access to.

cayuse IRB* cayuse IRB*

# Dashboard # Dashboard

I Studies B Studies

I Submissions I Submissions

" Tasks " Tasks

= IRB Users see all studies that they are involved with as PI, PC, Researcher, etc.
= Organizational Approvers see the studies that require their approval before proceeding.
= IRB Members see all studies that are or were assigned to them, or to the review board(s) they are a member of, for review.

= |IRB Analysts and Admins can see all studies in the system.

Reporting

The Reporting section lets IRB Analysts and Admins create and download custom CSV reports containing various study details and audit
information.
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[ Meetings

= Reporting

& Settings
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Tasks

The Tasks screen lists the studies that are assigned to you, along with the task that you are responsible for. Completing a task advances a
submission through the workflow.

cayuse IRB*

# Dashboard

I Studies

I Submissions

«" Tasks

7 Help

Notifications

The Notifications icon at the top of the screen lets you see the system messages that have been sent to you regarding the submissions you
are involved with. Click on the icon to display the list of notifications.

A & |RBUser
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User Settings and Actions

Clicking on your name in the upper right corner of Cayuse IRB displays a dropdown menu with two options.

cayuse IRB*® = Dashboard
# Dashboard
My Role: Analyst - Analyst
B Studies Researcher
Reviewer

I Submissions C,/‘ 1 18
In-Draft

E)

= -
Pre-Review

A

USER SETTINGS
% FavoriteRole Analyst
USER ACTIONS

¢ LogOut

Unde

& IRB Analyst

awT

r Review

User Settings - Favorite Role - If you have more than one user role (such as Analyst and Reviewer for someone who is both an IRB Analyst
and a member of a review board), certain screens (such as the dashboard) display different information depending on your role. These screens
have a dropdown in the upper left that allows you to select which user role you are currently working as. The Favorite Role option in the user

menu allows you to specify a default role which will be selected each time you log in to IRB.

User Actions - Log Out - Log out of Cayuse IRB.
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Help

You can click on the Help menu at any time to launch this in-product Help, or to view the release notes for this and all previous versions of
Cayuse IRB. The Help menu also contains tutorials that explain the Dashboard screen, and how to search for studies and submissions.

" Tasks

7 Help v

W

Open Help
Release Notes
View Dashboard Tutorial

View Visual Search Tutorial

Clicking the small 9 icons throughout Cayuse IRB open the Help to the page with information relating to that part of the application.
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Dashboard

When you first log in to Cayuse IRB, you will be taken to your Dashboard. This screen displays an overview of all the studies you are involved
with or that require your attention, and offers a quick way to view and filter studies, submissions, and tasks.

The dashboard looks different depending on your user role. An IRB User will see their studies, tasks and submissions:

Dashboard A & IRBUser

cayuse IRB*

# Dashboard
My Role: Researcher + New Study

I Studies
I Submissions @\ 9 4 E . 23
In-Draft Awaiting Approval E Under Review

+ Tasks

=

[ Meetings
My Studies My Tasks Submissions by Type
? Help IRB-FY2015-49 Evaporation of marine layers IRB-FY2016-91 Complete Submission Initial 10
IRB-2016-154 Use of compression in wound healing IRB-FY2016-84 View Submission ‘Withdrawal 1
IRB-2016-151 Social effects of early onset hair loss IRB-FY2016-84 Certify Submission Modification 2
IRB-FY2016-87 Sunlight exposure and depression Renewal 9
IRB-2016-148 Efficiency of hydroelectric dams Incident 1
Closure 1
Legacy 5
View All View All
Approved Studies Studies Expiringin 30days v Expired Studies
IRB-FY2015-49 Evaporation of marine layers IRB-FY2016-3515 Consumption of grass by felines
IRB-2016-154 Use of compression in wound healing
IRB-2016-151 Social effects of early onset hair loss

IRB-FY2016-87 Sunlight exposure and depression

IRB-2016-148 Efficiency of hydroelectric dams

View All View All
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Instead of the list of their studies, the IRB Analyst can toggle between a list of all unassigned submissions, and all submissions that are
assigned to them. The Analyst also has a list of all submissions that are currently under review, and can see a miniature meetings calendar.

cayuse IRB* = Dashboard A& & IRBAnalyst
# Dashboard
I Studies
e 4 o m 2 = = 1
In-Draft I.I.I.I. Awaiting Approval E Under Review
—
+ Tasks
£ Meetings
Submissions thatare Unassigned = My Tasks Submissions by Type
Reporting IRB-2016-149 Use of compression in wound healing IRB-2016-157 Complete Post Review Initial 294
IRB-FY2016-92 Complete Analyst Pre-Review Withdrawal 32
£ Settings
IRB-2016-149 Assign Analyst Modification 74
IRB-2016-145 Complete Post Review Renewal 39
? Help
IRB-FY2015-350 Complete Post Review Incident 24
Closure 22
Legacy 20
View All View All
Submissions under review Studies Expiringin 30days ~ My Meetings
IRB-FY2015-15 Review of obesity studies
51 < November 2015 >
)
ﬁ. Sun Mon Tue Wed Thu Fri Sat
Full Board Reviews
. .
01 0z 03 04 03 06 07
24 >
Expedited Reviews 08 09 10 11 12 13 14
.
15 16 17 18 19 20 21
.
° 16 2 23 24 25 2 27 28
- Exempt Reviews .
View Al 2 .

m The four status buttons across the top allow you to run quick filters on submissions which have the selected status. For instance,
clicking on the In Draft button takes you to the Submissions page and displays all of the submissions that are currently in draft (status
= Unsubmitted or status = Reopened).

m Clicking on a review type in the Analyst's Submissions under review pane takes you to the Submissions screen and automatically
searches for submissions with the selected review type.

= Clicking on the IRB number for a submission, study, or task takes you to the Submission or Study Details screen for that submission or
study.

= The Submissions by Type pane displays the counts of each submission type for all active studies. It does not include submissions for
archived studies, or administrative closure/withdrawal submissions.

m Calendar dates with a green dot have a meeting scheduled on that date. Click on the date to bring up the details of the meeting(s)
scheduled on that day.
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Studies and Submissions

Studies

The Studies screen lists all of the studies that you have access to. For IRB Users, this means all of the studies that you have created or are
involved in as a researcher. Organizational Approvers see the studies that have been assigned to them for review. IRB Members see the studies
that have been assigned to them or to their review board(s). IRB Analysts and Admins can view all studies in the system.

cayuse IRB* = Studies & & IRBUser
# Dashboard
) . + New Study
Active Archive
I Studies
Q Q
I Submissions
IRB# Study Title Status Pl Exp Date Create Date =
IRB-F¥2016-3559 Social effects of early onset hair loss @ Approved IRB User 04-07-2017 02-26-2016
IRB-FY2016-3557 Use of compression in wound healing @ Requires Changes IRB User N/A 02-26-2016
IRB-FY2016-3522 Extracurricular activities and perceived stress Under Review IRB User 2 N/A 02-26-2016
IRB-FY2016-3524 Internet use of adolescent Americans Under Review IRB User 2 MN/A 02-26-2016
IRB-F¥2016-3516 Social habits of Primolius maracona @ Approved IRB User 02-09-2017 02-10-2016
1-50f 5
1

You can sort the list of studies by expiration date or creation date. To sort on a column, click on its header.
Study Statuses
There are 11 different statuses that a study can be in:

= Approved - Study has been approved by the Compliance Office and/or Review Board.

m Closed - Study is no longer in progress.

= Disapproved - After being reviewed, the study was not approved by the Compliance Office/review board.
m  Expired - The study has passed its expiration date without being renewed.

= Legacy - Optional status that can be used when importing legacy submissions, in place of "Approved".

= Requires Changes - The Compliance Office has requested modifications to the study in order for it to be approved.
= Submitted - The PI has sent a submission to the Compliance Office and it is awaiting review.

= Suspended - Used when an incident has occurred to place the study on hold until further notice. The research team must submit a
modification in order to remove the suspension.

= Under Review - The Compliance Office and/or Review Board is currently reviewing the study.
= Unsubmitted - The study has not yet been sent to the Compliance Office for review.

= Withdrawn - The research team has submitted a withdrawal for this study and no longer wishes to pursue it.
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The Studies screenis divided into two tabs, Active and Archive. The Active tab displays all of the studies that are currently active within
Cayuse IRB. The Archive tab lists studies that have been closed, disapproved, or withdrawn.

cayuse IRB* = Studies A & IRBUser
# Dashboard
) i + New Study
Active Archive
I Studies
Q @ ArchivedWithin: ]
I Submissions
1year
{b Status Pl Archive Date Create Date ~
+ Tasks 2years
3years @ Closed IRB User 01-05-2016 02-26-2014
? Help
IRB-FY2014-1113 Effects of sunlight on seasonal affective disorder @ Closed IRB User 01-05-2016 02-26-2014
IRB-FY2014-2884 Depression in first-year college students @ Closed IRB User 01-26-2016 01-26-2014
1-30f 3
1

Submissions

Each study can have one or more submissions associated with it. When you first create a study, you must begin by creating an Initial
submission (or a Legacy submission if the study was imported from a previous system). The Submissions screen lists all of the submissions
relating to the studies that you have access to.

Note that some of the submissions are different types of submissions for the same study. For instance, an initial submission that was later
followed up by a modification submission for that study.

cayuse IRB*® = Submissions A & IRBUser
# Dashboard
Q o
B Studies
. Review . -
IRB# Submission Status T Pl My Assignment Decision Create Date ~
I Submissions ype
IRE-FY2016-3559 ool effectsofearlyonsethairloss g peyiew Camplete  Ful IRBUser  Principal Investigator ~ #PProved 03-09-2016
IRB-FY2015-3559  ocial effects of early onset hair loss Under Review Expedited  IRB User Principal Investigator 03-09-2016
IRB-FY2015-3557  Useofcompressioninwoundhealing g oo iy complete  Ful IRB User Principal Investigator ~ =XeMPE 03-09-2016
- - Internet use of adolescent Americans . I N a4
IRB-FY2016-3524 s Under Pre-Review Full IRB User 2 Primary Contact Returnto Pl 03-02-2016
IRB-FY2016-3557 e of compression inwound healing Under Review Full IRBUser  Principal Investigator  Not Reviewed 03-02-2016
. . P No Human
Social habits of Primoll
IRE-EY2016-3516  ppaininn oo A€M g Review Complete  Exempt IRBUser  Principal Investigator  Subjects 02-25-2016
Research
25 per page - 1-60f 6 1

You can resort the list of submissions by creation date in ascending or descending order by clicking on the column header.
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Searching for Studies or Submissions

To filter the list of studies or submissions, click in the search box and select the attribute you wish to filter by. You can also simply enter your
search term(s) to search all available fields.

cayuse IRB*® = Studies A & IRBUser
# Dashboard
Active Archive + New Study
Q| o
I Submissions
All
Status PI Exp Date Create Date ~
Expiring Within {b
IRB# “loss @ Approved IRB User 04-07-2017 02-26-2016
Pl
2aling @® Approved IRB User 04-06-2017 02-246-2016
Status
Study Title srceived stress @ Requires Changes IRB User 2 /A 02-246-2016
IRB-FY2016-3524 Internet use of adolescent Americans Under Review IRB User 2 /A 02-26-2016
IRB-FY2016-3516 Social habits of Primolius maracona ® Approved IRB User /A 02-10-2016
25 per page - 1-50f 5 1

Once you select a value, you will see a second list of suggestions for values to search for. You can choose a value from this list, or free type
your own.

Q  © ExpiringWithin: | Q

30 days
{b Status Pl Exp Date Create Date ~
60 days

90 days “loss @ Approved IRB User 04-07-2017 02-26-2016

Expired
AL i s wam ur vurier saaron nn veouna n2aling @ Approved IRB User 04-06-2017 02-26-2014

If desired, you can add additional search filters by clicking in the white space in the search bar. When finished, press enter to search.

cayuse IRB* = Studies & & IRBUser
# Dashboard
Active  Archive
Q  © ExpiringWithin: 1year °
I Submissions
IRB# Study Title Status PI Exp Date Create Date ~
IRB-FY2016-3559 Social effects of early onset hair loss @ Approved IRB User 04-22-20146 04-23-2015
25 per page ™ 1-10f1 1
To go to a study or submission, click anywhere in that row.
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Tasks

Whenever a study changes state, Cayuse IRB assigns one or more tasks to various users. For example, when a researcher first saves a new
submission, the system assigns them a "complete submission" task. The task assignments tell you what you need to do next in order to
proceed with the submission.

The Tasks screen lists all of the tasks that are currently assigned to you. Click on any task to open the submission associated with that task.

cayuse IRB* = Tasks A & IRBAnalyst
# Dashboard
My Role: Analyst -
B Studies
Q Click to search =]
I Submissions
IRB# Task Study Submission My Assignment Tasked Date ~
IRB-FY2014-53 Complete Post Review Use of compression in wound healing Initial Analyst Today
[ Meetings
IRB-FY2016-51 Complete Analyst Pre-Review Saocial effects of early onset hair loss Initial Analyst 10-21-2015
= Reporting ) N . - .
IRB-FY2016-20 Complete Post Review Prevalence of allergies in cat owners Initial Analyst 08-11-2015
& Settings IRB-FY2016-9 Assign Analyst Attitudes and perceptions of GM wheat Withdrawal Analyst 08-11-2015
? Help 25 per page - 1-40f 4 1

If you have more than one user role-- for instance, you are an IRB Analyst but sometimes review submissions as well-- the task list only shows
tasks that pertain to your currently-selected role. To change your user role, use the Role dropdown at the top of the screen.

When you complete a task, it is removed from your task list. You may then see another task assigned to you for the next step in the process,
or another user may receive a task depending on where the submission is in the workflow.

Depending on how your IRB Administrator has configured the application, you may receive email notifications for tasks at periodic intervals.
Administrators can specify how frequently to send reminder emails for outstanding tasks via the Application Settings screen.

The task list for the IRB Analyst above shows several studies that are waiting to be assigned to an Analyst. Assigning the study to a particular
Analyst for review is the next step, and these tasks will appear in all IRB Analysts' task lists until this is done.
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Notifications

The Notifications icon shows you a list of all the messages you have received regarding one of your studies. In the example below, this IRB
User has received notifications for several studies. The notifications for the first three studies indicate that various submissions have been
received by the IRB office. The fourth notification pertains to a study that has expired. You will get a notification whenever one of your studies
requires some action by a different user or user role.

cayuse IRB* = Dashboard & & IRBUser
# Dashboard Motifications

ission Received x

B Studies

I Submissions y‘ 3 i 1 B In(‘:ider’:t.s_t-lh:nission Re.:cei:\;ea x 1
— A Wz

+ Tasks

Closure Submission Received x

? Help [ -
My Studies My Tasks Stl:ld h: éxpiir;e:d B - x
|RE-EY2014-3502 Sol(ial effects of early onset IRB-FY2015-76 Complete Submission - - 4
hair loss RB-FY2015-7262 | PI: IRB User2
IRB-FY2016-3516 View Submission Withdrawal 0
. _ Use of compression in wound
IRB-FY2016-3546 healing Modification 6
Prevalence of allergies in cat Renewal 2
IRB-FY2016-3524
owners
Incident 1
Effects of light I
IRB-FY2015-1118  , coro 0 Sunentonseasona Closure 0
affective disorder
Legacy 3

Pravalanca of sllaraiac in dne

View All View All

Notifications are sent:

= To the Pl when the submission has been sent to them for certification.
= To the Pl and PC, when their submission has been received by the Compliance Office.
= To the Organizational Approver(s) when a submission requires approval.
= To the IRB Analyst when a new submission requires Analyst assignment.
= To the previous IRB Analyst, when a submission is reassigned to another Analyst
m To the IRB Analyst when an expedited review is complete.
= To the board members or reviewers when a submission requires their review.
= To the Pl and PC when a study is expiring or has expired.
= To the primary and/or secondary reviewer(s), when an Analyst has added a comment to the submission.
Many of these notifications are also sent via email to ensure the recipient sees the message in a timely manner. In particular, the Pl and other

contacts listed on the submission receive emailed notifications whenever the submission moves to a new step in the workflow (when it is
reviewed and approved, returned to the P, etc.).

Clicking on a notification takes you to the submission that notification pertains to. Viewed notifications are no longer highlighted in the
Notifications list. You can delete notifications from the list by clicking the X icon next to that notification, or use the ... menu to mark all
notifications read or to delete all notifications.

Customizing Notifications

IRB Analysts and Admins have the ability to customize all of the notifications and emails that are sent out by Cayuse IRB via the Message
Templates screen in the Settings section. Customization options include editing the text of the message, controlling which users receive it,
or disabling certain types of notifications.
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Creating a New Study

To create a new study, click the New Study button in the upper right of either the Studies page or your Dashboard.

cayuse IRB* = Studies A & IRBUser
# Dashboard
I Studies
Q Q
I Submissions
IRB# Study Title Status Pl Exp Date Create Date ~
« Tasks
IRB-FY¥2016-3522 Extracurricular Activities and Perceived Stress Unsubmitted IRB User 2 N/A 03-18-2016
7 Help
IRB-FY2016-3524 Internet Use of Adolescent Americans @ Approved IRB User 2 03-04-2017 03-04-2016

Enter a title for your study (up to 600 characters). Then, click the Save button.

cayuse IRB* Study Details A & IRBUser

o [Lairaend) Studies =~ Study Details

Study Details Submissions

I8 Studies

I Submissions

Social Effects of Early Onset Hair Loss
+ Tasks

:
? Help ! l

Approval Date: Expiration Date: Organization: Active Submissions:

N/A N/A N/A

Sponsors: Closed Date:

N/A N/A

After creating the new study, you will be taken to the Study Details page for that study, which displays important information regarding the
study.

Editing Study Titles

You can choose to rename your study at any point up until the initial (or a withdrawal) submission has finished being reviewed. From the
Study Details screen, click anywhere within the study title field to edit the title.
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Creating the Initial Submission

To begin working on your study, click New Submission to add the Initial submission for your study.

Study Details I 3 & IRBUser

cayuse IRB*

o D Studies = Study Details 4+ New Submission
B Studies i o Initial
Study Details Submissions {b

I Submissions

IRB-FY2016-3575 Social Effects of Early Onset Hair Loss

[ PDF T Delete
Approval Date: Expiration Date: Qrganization: Active Submissions:
Sponsors: Closed Date:
Key Contacts Attachments
Team Member Role Number Email

Mo Key Study Contacts.

The initial submission appears below the study details. The person who creates the study is added as the PI by default. You can change this
when editing the submission, if needed. Click the Edit button to begin working on the initial submission.

cayuse IRB* = Submission Details A & IRBUser
o i Studies = Study Details  Submission Details
B Studies
1 In-Draft
Submission is with researchers

I Submissions

Initial

IRB-F¥2016-3 - Social Effects of Early Onset Hair Lo

# Edit PDF ~ @ Delete

PI: Current Analyst: Decision: Required Tasks:

IRB User N/A N/A I

Review Type: Review Board: Meeting Date: & Assign PC

N/A N/A N/A « Complete Submission
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You will now be taken to your institution's initial submission form, where you can begin filling out information. Your study is saved, and you
can return to the Study Details page at any time by clicking on the < STUDY link in the upper left of the screen.

cayuse IRB* = A & IRBUser
‘ IRB NUMBER: IRB-FY2016-3575 B CREATE POF T COMPARE >
# Dashboard € STUDY = . .
ashboar, Social Effects of Early Onset Hair Loss - Init...
B Studies £ZEEE
I Submissions
Section 2 Other ltems *P1  Principal Investigator
+ Task: a a
kS Section 3 Optional Forms Name Organization Address Phone Email
2 Help IRB User School of Medicine zi\o Exchange, Irvine, ;é:fég irbuser@evisions.com x
*P2  Primary Contact
FIND PEOPLE
>
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Completing Forms

When you create a new submission for your study, the submission prompts you for the information required by your institution's template for
that particular submission type. There may be multiple sections in the template, as well as actions and attachments that you can provide.

cayuse = My Role: Researcher a4 & IRBUser
Y

IRE NUMBER: IRB-FY2016-3576

£ STUDY ‘ H = (e I CREATEPDF M COMPARE >
# Social effects of early onset hair loss - Initial
[BEELLLETS
Sections
L General Information
Studies
L e #1.  Principal Investigator
Submissions Study Information Name Organization Address Phone Email
Subject Information IRB User School of Medicine ?‘:AAO Exchange, Irvine, ;;31255 irbuser@evisions.com x

Advertisements

*2.  Primary Contact

Please select the Primary Contact for this Protocol.

FIND PEOPLE

3. Anticipated Start Date

The section you are currently working on appears in the menu in green text. As you provide information, the status bar underneath the section
turns green. When complete, the section name has a green check mark to its right. Sections with no required questions are marked complete
when you visit the section for the first time.

cayuse = y Role: Researcher cer
y = My Role: R h a = IRBU

I CREATEPDF M COMPARE < >

IRE NUMBER: IRB-FY2016-3576

# <suor | Social effects of early onset hair loss - Initial

[BEELLEG]

Sections

Studies

General Information Location of Research

‘ 1. Will your research be conducted on campus?
Submissions Study Information Yes

® No

Subject Information a.  Select the type of facility where the research will be conducted.
Correctional Facility

Home Health Agency

Veterans Hospital

Health Clinic

Other

Advertisements

Use the < and > buttons to navigate to the previous and next sections. You can also click on a section name in the menu at left to jump to that
section.
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Simultaneous Users

More than one member of the research team (PI, Co-PI, Primary Contact, or another authorized Investigator) can be working on different
sections of a submission at the same time. When another user is currently working on a section, that section will have a red lock icon in
the section menu and you will not be able to make edits to that section. You can still work on other sections that are not locked. To see
who is currently editing a locked section, hover over the lock icon in the section menu.

Sections
B Studies

Section 1 Assignme...

B Submissions

Section 2 Other ltems

1. Pland pPC?
+ Tasks i
3 Optional Form lte... @ Yes
A submission cannot be completed while another user is still editing it.
L
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Types of questions

There are several types of questions that you may see on a submission form:

Radio Buttons

Select one of the available options.

#1.0 What type of submission is this?
Research Study Involving Human Subjects (Exempt, Expedited, Full Board Review) oversight by the
Cayuse University IRE
Research Study involving an Outside IRB of Record or NCI PCIRB
Emergency Use of Investigational Agent

Request for Determination of the Need for IRB Review

Check Boxes

Select one or more of the available options.

#30  Inwhich locations will the research take place? (Check all that apply.)
Inpatient Location
Outpatient Location
Community Settings
Subject's Home

N/A (limited to review of records, data and analysis)

Date Picker

Click the calendar icon to browse for a date.

7.2 Date the event started:

02/27/2014 =
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Text Box

A text box provides space for a short answer that does not require a lot of explanation. You can enter multiple lines of text here if needed;
the box will expand to fit the text.

%30 Create a SHORT title for your research protocol. (Five words maximum.)

Text Area

The multi-line text editor allows you to apply simple text formatting such as bold, italics, underline, strikethrough, bulleted lists, numbered
lists, and hyperlinks.

#20 Whatis the FULL title of the research protocol?

B I u 5 i=E O=E 2 (W

You can also add PNG or JPG images using the image browser. To add an image to the text area, click the [&al icon in the toolbar.

Add Image

Choose source:

®*  Upload Choose File
Web URL
Clipboard
Cance
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Depending on your browser, you have a choice of three possible image sources:

= Upload - Use the Choose File button to browse for animage on your computer or from a network location.
= Web URL - Paste the URL to an image that is hosted online.
= Clipboard - Paste an image that you have copied to your clipboard. Due to browser limitations, his option is only available to
Chrome users.
Click Confirm to import the image.

Once the image is inserted, you can resize it as needed by clicking and dragging on the corners. When you hover over the image, an Edit
button appears that opens a dialog where you can add a title for the image, turn the image into a hyperlink, or adjust the image position
relative to the flow of text.

Edit

Title

Evisions logo

Link
WWW._evisions.com

¥| Open link in new tab

Position
Center »
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Person and Sponsor Finders

Some fields require a single person, such as the Primary Contact for a study:

#1.0  Who is the Primary Contact?

FIND PECPLE

Click Find People to bring up the Primary Contact search dialog:

PRIMARY CONTACT

Mark Q
Name Organization Email Phone
Mark Williams Biomedical mwilliams@evisions.com 714 824 5478 @
Mark Klein Biomedical mklein@evisions.com 714824 1234 +
Selected Records * Select a single record.

No records selected. Select a record and click Save fo apply.

@ CANCEL

Type the name or part of the name of the person you are looking for in the search box and click the Search icon. Locate the desired person
in the list, then click the + button next to their name to add them to the selection. Click Save to return to the form.

Other People fields allow you to select more than one person. For example, when you click Find People, the Investigator search dialog
allows you to select any number of investigators using the + buttons. When you add a person to the selection, the + button changes to a
check mark.
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INVESTIGATOR

Mark Q
Name Organization Email Phone
Mark Williams Biomedical mwilliams@evisions.com 714824 5678 v
Mark Klein Biomedical mklein@evisions.com 714824 1234 v

Selected Records

Mark williams x

Mark Klein x

@ CANCEL

When you have added all the people you wish to include, click Save.

Sponsor finders work exactly the same way as Person finders, except that the search returns matching sponsors instead of people.
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Attachments

Attachment fields allow you to upload one or more files to the study, or to include hyperlinks as "attachments".

40  Attach the Letters of Support from the respective Department/Division.

ATTACH

Click Attach to open the Documents window. To add a file or link, click the + button and choose to add a URL or file.

DOCUMENTS

Click the plus button to upload files or add links.

-*= @ CANCEL B APPLY

Add Link

Add File h
Mo file chosen

Choosing Add File launches the default file browser on your system. Choosing Add Link opens a text area where you can enter the URL and a
title for the page:

DOCUMENTS

Add Link
Title URL
Google http://www.google.com

@ CANCEL + ADD

Click the plus button to upload files or add links.

ek @ CANCEL B APPLY

Enter the desired URL or select the desired file, then click Apply.
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Supported File Types

Cayuse IRB supports the following file types. Each file can be a maximum of 20 MB in size.

File Type Extension

Text txt
Adobe pdf
Raster image formats | png, bmp, gif, tif, tiff, jpg, jpeg, jp2, jpx

Vector image formats | wmf, emf, svg

Microsoft Word doc, docx, docm

Microsoft Excel xls, xIsx, xIsm

Microsoft PowerPoint | ppt, pps, pptx, pptm, ppsx, ppsm, sldx, slkdm

Deletfing Attachments

To delete an attachment, click the X icon next to the attachment. You can also download file attachments by clicking on the filename.

cayuse IRB* = My Role: Researcher J & IRBUser
IRE NUMBER: IRB-FY2016-3576

Social effects of early onset hair loss - Initial

B CREATEPDF  [T] COMPARE <N

#

Dashboard

€ STUDY ‘

Sections
# 1. Does this research fall under any other committee?

L General Information
Studies Yes

® No
E

Submissions

Location of Research

Study Information
+2. Attach Protocol

Subject Information
v ATTACH

Advertisements "
I Study Protocol.pdf \ »x

Required Questions

Some questions have a red asterisk (*) next to the question number. This indicates a required question that must be answered before you
can submit.

Saving Your Changes

Sections that have unsaved changes have an asterisk next to the section name in the menu. To save your changes, click the Save button in
the upper right.
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Help with questions

A question may provide additional information in case you need assistance with that particular question. If there is help text for a question,
you can click on the (?) button to the right of the question to view the additional information for that question.

#1.0 What type of submission is this? This is some help text. )

Research Study Involving Human Subjects (Exempt, Expedited, Full Board Review) oversight by the
Cayuse University IRBE
Research Study involving an Qutside IRB of Record or NCI PCIRE

Emergency Use of Investigational Agent

Comments

When the IRB Office is reviewing a submission, the IRB Analyst or Members may have questions regarding some of your answers. If the
submission gets returned to you, you will see a comment icon in the sidebar next to each section that contains comments, and a similar icon

underneath the questions that have comments on them. Click the @D Expand Comments iy 46 see and respond to these comments.

%PC  Primary Contact

FIND PEOPLE
Name Organization Address Phone Email
Bob Rawley School of Medicine 440 Exchange, Irvine, CA 714 265 7498 brawley@evisions.com

® Collapse Comments

IRB Analyst
Are there any additional contacts for this study?

IRB User
Mo, there are no additional contacts.

Addressed w
IRB Reviewer

I think there should be more contacts. What if the first one is out
of the office?

When you have responded to a comment, change the dropdown from Not Addressed to Addressed . Unaddressed

comments have a red bar to their left, and display the comment count in the comment bubble icon for that question. You can toggle
comments between addressed and unaddressed as needed.
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Routing

If there are available actions that you can perform, the Routing menu appears prompting you to perform the action. For example, when you
finish filling out all parts of the submission, a "Complete Submission" link appears in the Routing menu. Completing the submission will send

it to the PI for certification, which is the next step in the submission workflow.

cayuse IRB = My Role: Researcher J 3 & IRBUser
‘ IRB NUMBER: IRB-FY2016-3576 B CreaTEPOF [T COMPARE <
£ STUDY H H +1
# Social effects of early onset hair loss - Initial
Dashboard
Sections
= General Information Advertisements
Studies
‘ Ll di *1. Will advertisements be used durinz vour research protocol?
. Please see policy: Advertisement Policy
Gl Study Information
Yes
Subject Information ® No
Routing
Send to Pl for certification?
COMPLETE SUBMISSION >
<
Evisions Leave Feedback | Contact Support
Research Suite Powered by Evisions, Inc. Copyright © 2015. Al rights reserved
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Submission Workflow

Once you have completely filled out every section in the study and included all required attachments, a Complete Submission option appears

under Routing in the menu when inside the submission:

cayuse IRB

= My Role: Researcher

{ STUDY ‘

Sections
General Information
Location of Research
Study Information

Subject Information

Routing
Send to Pl for certification?

COMPLETE SUBMISSION

IRBNUE‘IBER: IRB-FY2016-3576 . ..
Social effects of early onset hair loss - Initial

Advertisements

+1.  Will advertisements be used during vour research orotocol?

2 Yes
® Mo
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If you are on the Submission Details screen, you will also see the Complete Submission link indicating the next step in the routing process:

cayuse IRB* = Submission Details A & IRBUser
# Studies / Study Details / Submission Details
Dashboard
- In-Draft
Submission is with researchers
Studies
[
Submissions Initial
RB-FY2016-3556 - Social effects of early onset hair loss
v
Tasks # Edit I PDF W Delete
N Pl: Current Analyst: Decision: Required Tasks:
) IRB User N/A A Assisn Pl
Review Type: Review Board: Meeting Date: AssignPC
et Unassigned N/A N/A « Complete Submission
Settings Approvals. Task History
? Research Team
Name Role Result Date
No entries.

After clicking Complete Submission in the study sidebar, you will be prompted to confirm or cancel. Confirming marks the submission as
completed and sends it to the Pl (and possibly to any Co-Pls, depending on your institution's settings) for certification. It sends an email to the
Pl and places the study in their inbox to be addressed.

If everything is correct, the Pl can then Certify the submission. By certifying the submission, the Pl asserts that the submission is complete and
accurate, and that they accept their responsibilities as Pl of the study.

Note: Your institution's settings may require that any Co-PlIs on the study also certify it, in addition to the PI's certification. IRB Administrators
can specify this behavior in the Application Settings.
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Certify

| confirm that | have the proper training, expertise and
resources to conduct this study. | understand and accept my
responsibilities as the Principal Investigator and Primary
Contact for this study. | confirm that | have no significant
financial conflict of interest in this project or have disclosed a
conflict per institutional policies and federal requirements. |
confirm that the information provided in this application is
true, complete, and accurate to the best of my knowledge; that
any false, fictitious, or fraudulent statements or claims may
subject me to criminal, civil, or administrative penalties; and
agree to accept responsibility for the oversight and scientific
conduct of the project.

Alternatively, if the Pl decides that changes need to be made, they can send the submission back to the research team by clicking Return to
Investigators. The research team members will receive an email notification of the change in status so they can make the necessary edits
before marking it complete again.

Once the PI has certified the submission, it goes to the departmental approver for review, and from there goes down the chain to the IRB
analyst and members. At any point the submission may be returned to the investigation team to answer questions or to make changes.

Submit to all IRB
members for —
review

Does
full IRB
approve?

Full IRB meeting

No; needs full board approval

ioar Is Lo

Investigation team Does Submit for Does ‘ o Submit to specific Do IRB Submission

enters data Sl :’ oy Pl certify Yesp  department dept. approve > Ye: MBI C;‘:;;:'g:d IRB members for members Yes. accepted

[=vicw) submission? eroval submission?, analyst e etiew] approve?
No No No o

Send back to Pl or ¢—‘ ——

for editing ¢ accoptanca
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Letters

At certain points in the workflow, the compliance office may send communication to the Principal Investigator in the form of a letter notifying
them of status changes, approvals, information required, etc. Letters are sent via email, and are also available to download from the
submission in Cayuse IRB.

The Letters tab appears for a submission when there is at least one letter associated with that submission. Click on the Letters tab to view the
letters associated with the submission.

cayuse IRB*

# Dashboard

B Studies

I Submissions

Studies / Study Details ' Submission Details

Awaiting Approvals
Submission is awaiting
certification or approval

In-Draft
Submission is with researchers

Review Complete
Initial
IRB-FY2( s of early onset hair loss
* View I PDF
Pl: Current Analyst:
IRB User IRB Analyst
Review Type: Review Board:
Full Biomedical
Approvals Task History Letters Meetings
Subject

IRB-FY2016-55 - Initial: Approval - Full Board

IRB-FY2016-55 - Initial: Revision Needed

Submission Details

Pre-Review
Submission is being prepared for
review

Decision:

Approved

Recipients

IRBUser@evisions.com

IRBUser@evisions.com

4 a

Under-Review
Submission is with reviewers.

Sent Date
11-09-2015

09-01-2015

IRB User

Each line contains the subject, send date, and recipient(s) of a letter. You can click anywhere on the line to open a PDF of the letter in a new
browser window.

To: IRB User

School of Medicine

Approval Date: Thu, 27 Feb 2014

Expiration Date of Approval: Fri, 27 Feb 2015

RE: Notice of IRB Approval by Expedited Review (under 45 CFR 46.110)
Submission Type: Initial

Study #: IRB-FY2015-390

Study Title: Social Effects of Early Onset Hair Loss

This submission has been approved by the above IRB for the period indicated.

Investigator's Responsibliities:

Federal regulations require that all research be reviewed at least annually. It is the Principal Investigator's
responsibility to submit for renewal and obtain approval before the expiration date. You may not continue any
research activity beyond the expiration date without IRB approval. Failure to receive approval for continuation before
the expiration date will result in automatic termination of the approval for this study on the expiration date.

When applicable, enclosed are stamped copies of approved consent documents and other recruitment materials.
You must copy the stamped consent forms for use with subjects unless you have approval to do otherwise.
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To save the letter to a file, right-click within the opened PDF and select Save As (Chrome) or Save Page As (Firefox), or go to Tools -> File ->
Save As (Internet Explorer).
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Addressing Comments

When a submission has been certified and sent to the IRB Analyst, the Analyst may comment on various questions on the form. The Analyst
will return the submission to the investigators with any comments if you need to correct an issue, add additional information, etc.

Sections with unresolved comments have a comment bubble icon to their right indicating the total number of unresolved comments in that
section. Questions with new comments show a gray comment bubble and the number of comments for that particular item underneath the
question:

cayuse IRB = My Role: Researcher A & IRBUser
‘ IREB NUMBER: IRB-FY2016-3559 E e —— (] COMPARE >
£ STUDY 4 = HE
# Social effects of early onset hair loss - Initial
[BELLLEG]
Sections
i Section 1 Assignments
Studies
‘ Section 2 Other ltems #P1  Principal Investigator
Submissions Section 3 Optional ... Name Organization Address Phone Email
IRB User School of Medicine :;O Exchange, Irvine, ;éjlﬂﬁ irbuser@evisions.com
Routing
Send to Pl for certification? #P2  Primary Contact
COMPLETE SUBMISSION Name Organization Address Phone Email
IRE User2 Biomedical g‘;\o Exchange, Irvine, 5138265 irbuser2@evisions.com
pEuuand Comments.

You may see comments from the IRB Analyst, your Organizational Approver, or from the IRB member(s) reviewing the submission, depending
on how far the submission progressed through the approval process.

Click on the SIExpand Comments 1 45 yiew the comments associated with each question. You can then reply to the comment below.

cayuse = y Role: Researcher cer
Y = My Role: R: h J & IRBU

IRBE NUMBER: IRB-FY2016-3559

€ STUDY ‘ A . i I CREATEPDF  [I] COMPARE >
# Social effects of early onset hair loss - Initial
Dashboard
Sections #*P2  Primary Contact
. Name Organization Address Phone Email
Studies IRB User2 Biomedical 3\0 Bxchange, Irvine, ;12;65 irbuser2@evisions.com
Section 2 Other ltems
‘ pCollapseCommenls
Submissions Section 3 Optional ...
IRB Analyst Todayat1:21PM
Arethere any additional centacts for this study?
Reply
B I U & = = &
Routing o
T No. there are no additional contacts|
COMPLETESUBMISSION ¥
[# REPLY % CANCEL
Enter your reply and then click HEREPLY 45 save it.
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Once you have resolved an issue, change the status dropdown from Not Addressed w to . Addressed comments

have a green sidebar and the comment count no longer appears on the comment bubble icon for that question (unless there are other
unaddressed comments for that question). You must mark all comments as addressed before the submission can be re-certified.

cayuse |IRB = My Role: Researcher

IRBE NUMBER: IRB-FY2016-3559
* € STUDY

A & IRBUser

Dashboard
Sections +P2  Primary Contact

Studies IRB User2 Biomedical CA
Section 2 Other ltems
E

Submissions

# Collapse Comments

Section 3 Optional ...
IRB Analyst Todayat 1:21PM

Are there any additional contacts for this study?

Reply

IRB User Todayat2:09PM

Routing .
Send to Pl for certification? No, there are no additional contacts.

Reply

COMPLETE SUBMISSION

PR YA Today at 2:08 PM by you

. . ope I CREATEPDF  [T] COMPARE >
Social effects of early onset hair loss - Initial
Name Organization Address Phone Email
440 Exchange, Irvine, 714265 B .
7498 irbuser2@evisions.com

Once all comments on the submission have been addressed, the Pl (or Co-PI, depending on your institution's settings) will need to re-certify

the submission to return it to the IRB Analyst.
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Submission Types

When you first create a study, you also create the initial submission outlining the purpose of that study. In addition to this initial submission,
there are five other types of submissions that IRB Users may submit during the course of your research. The available submission types include:

Initial - This is the first submission that you create when you enter a new study in the system. The initial submission describes the
research you intend to do and the methodology you intend to use. The initial submission must be approved before any research can
begin.

Modification - If you wish to change any of the details of the study after it has been approved, you must submit a modification which
must be approved before you can proceed with the changes.

Renewal - When a study is nearing its expiration date, you must submit a renewal request in order to continue with the research. The
renewal will need to be approved before you can continue with the study.

Incident - You must submit an incident report to inform the Compliance Office of any adverse incidents, as required by your
institution. Incident reports may be submitted at any time after a study has been approved, including after it has been closed. More
than one incident report may be created for a given study, as needed.

Withdrawal - A withdrawal submission notifies the Compliance Office that you no longer wish to submit your initial submission and
want to withdraw the study. Withdrawn studies are marked as finalized and can no longer be modified. You may create a withdrawal
submission at any point once an initial submission has been created, until it has been approved. If the initial submission has been
approved, you must create a closure submission in order to close the study if you no longer wish to conduct the research.

Closure - A closure submission indicates that the research is complete and will not be continuing. Closed studies are marked as
finalized and can no longer be modified.

Legacy - Used for studies imported from previous systems. The legacy submission replaces the initial submission for imported
studies. Once the legacy submission is finalized, you can create additional submissions such as modifications, renewals, etc. An

IRB Analyst must create and publish a legacy template before users can create legacy submissions or work with studies that have been
imported from other systems.

There are two additional submission types that are only available to IRB Analysts and Admins:

Admin Closure - Allows a study to be administratively closed when needed, for example when the Pl leaves the institution or chooses
to let a study expire.

Admin Withdrawal - Allows a study to be administratively withdrawn when needed, for example when the Pl leaves the institution.

Each submission type has its own template that the IRB Analyst or Admin configures via the Manage Submission Templates screen.
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Viewing Submission History

To view the submission history for a study, go to the Study Details page and click on the Submissions tab:

(VLA =  MyRole: Researcher ~ Study Details & & IRBUser
* Studies - Study Details
Dashboard
Study Details
-
Studies
Submission Type Review Type Status Decision Last Modified
Submissions Initial Full ® Review Complete Approved 03-09-2015
Modification Expedited ® Review Complete Approved 03-09-2015
Modification Full Under Review N/A 03-09-2015
PageSize: 25 - 1-30f3 1

Meetings

The Submissions tab shows the list of submissions associated with the study, including the submission type, review type and status, decision,
and last modified date. Click on any submission in the list to go to its Submission Details screen:

(TRl =  MyRole: Researcher ~ Submission Details A & IRBUser
P Studies / Study Details / Submission Details
Dashboard
In-Draft Awaiting Approvals Pre-Review Under-Review
e Submission is awaiting certification or view Sromeview .
. Submission is with researchers approval Submission is being prepared for review Submission is with reviewers
Studies
E Review Complete
Submissions Initial
IRB-FY2016-3531 - Social effects of early onset hair loss
@ View K PDF
Meetings Pl: Current Analyst: Decision:
IRE User IRB Analyst Approved
Review Type: Review Board:
Reporting Full Biomedical
Settings Approvals Task History Letters Meetings Decisions
Research Team
Name Role Result Date
IRB User Principal Investigator Certified 03-09-2015 8:41am
IRB User 2 Primary Contact Completed by IRB User

Notice the Approvals, Task History, Letters, Meetings, and Decisions tabs showing for the initial submission. Click on the desired tab to locate
the information you require.
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Working with Legacy Studies

When a study is first imported from a previous IRB system into Cayuse IRB, the study does not have any submissions associated with it. If an
investigator wishes to continue working with the study, they (or an IRB Analyst) must first create a Legacy submission for the study. The
Legacy submission is used in place of the Initial submission. Once the legacy submission is finalized, you can create additional submissions
such as modifications, renewals, etc. and work with the study as you would any other study in Cayuse IRB.

Note: An IRB Analyst or Admin must set up and publish a template for Legacy submissions on the Submission Templates screen before
you can create a Legacy submission.

When you first open the imported study, the only available submission type is the legacy submission. Click New Submission -> Legacy to
proceed.

Study Details A & IRBUser

cayuse IRB*®

Bt Studies ~ Study Details + New Submission
I Studies
Study Details Submissions ez {b

I Submissions m

v Tasks IRB-FY2011-126 Use of Compression in Wound Healing

[& PDF T Delete

? Help

Approval Date: Expiration Date: Organization: Active Submissions:
11-15-2011 N/A N/A N/

Sponsors: Closed Date:

Key Contacts Attachments
Team Member Role Number Email
IRB User Principal Investigator

IRB User 2 Primary Contact

The legacy submission is added in a similar manner to the first initial submission, but using the Legacy template instead of the Initial template.
Click Edit to see the data on the legacy submission form.
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cayuse IRB* = Submission Details A & IRBUser
# Dashboard Studies ~ Study Details = Submission Details
B Studies
1 In-Draft
Submission is with researchers

I Submissions

Legacy

IRB-FY2011-126

# Edit PDF ~ @ Delete
PI: Current Analyst: Decision: Required Tasks:
IRB User N/A MN/A ~ c -
¢ Complete Submission
Review Type: Review Board: Meeting Date:
N/A MN/A N/A

Note: Some of the data, such as the Principal Investigator, may be prepopulated into the submission form. You must save the form in order
for these changes to be remembered.

When you are finished editing the form, click Complete to finalize the legacy submission. You then have the option to create additional
submissions for this study, such as renewal, modification, incident, or closure submissions.
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Linking a Study to Cayuse SP

If your institution has purchased Cayuse SP, any Cayuse IRB user now has the option to link each study in Cayuse IRB with one or more
proposals in Cayuse SP.

cayuse IRB*®

Study Details A & IRBUser

Studies = Study Details + New Submission
Study Details Submissions

# Dashboard

I Studies

I Submissions

¥ Tasks IRB-FY2016-3584 Social Effects of Early Onset Hair Loss

? Help [& PDF % Link Proposal
Approval Date: Expiration Date: Organization: Active Submissions:
e e e + Initia
Sponsors: Closed Date:
Key Contacts Attachments
Team Member Role Number Email
IRB User Principal Investigator
Click the Link Proposal button on the Study Details screen to launch the Proposal Finder.
cayuse |IRB* = Study Details A& & IRBUser
# Dashboard
B Studies Link Proposals
I Submissions Proposal # Lead Pl Status Begin Date End Date Linked Linked Propaosals
16-0005 IRB User UNSUBMITTED 10-31-2015 10-31-2015 16-0006 x
« Tasks
16-0006 IRBUser  UNSUBMITTED  10-31-2015  10-31-2015 (L
? Help
16-0007 IRB User UNSUBMITTED 11-19-2015 11-26-2015

Cayuse IRB automatically searches for SP proposals associated with the researchers assigned to the study in Cayuse IRB. If you are not seeing
the proposal you want to link, make sure that you have created an initial submission and assigned a Pl and the researcher(s) associated with
the Cayuse SP proposal.

Select the study or studies you wish to link using the green Linked toggle, then click Done.
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The linked proposal(s) appear above the Key Study Contacts on the Study Details screen:

cayuse IRB*®

Study Details a & IRBUser

(g =bed Studies = Study Details 4 New Submission
Study Details Submissions

B Studies

I Submissions

v Tasks IRB-FY2016-3584  SPLink test

? Help & PDF % Link Proposal
Approval Date: Expiration Date: Organization: Active Submissions:
A WA A « Initia
Sponsors: Closed Date:
Key Contacts Attachments Linked Proposals
Proposal # Lead Pl Status Begin Date End Date
16-0006 IRB User UNSUBMITTED 10-31-2015 10-31-2015

You can now click on the proposal number to view the proposal in Cayuse SP.

To remove the link to the proposal, click the Link Proposal button to open the Proposal Finder again, and remove the link by clicking the X
next to the linked proposal..
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